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Indications of Medical Devices Act 

1. Product Category: IVD Reagent for Infectious Agents 

2. Product Name: U-TOP™ COVID-19 Detection Kit 

3. Product Catalogue Number: SS-9011 

4. Purpose of use: See 1. in this User Guide 
 
 
 
 
ㅣWarnings and Precautionsㅣ 

Contact us for detailed information for the 
safe use of the U-TOP™ COVID-19 
Detection Kit. Please check storage 
temperature and attention points for accurate 
diagnosis of the product. Sample and Assay 
waste must be disposed of in a legally 
designated manner. 

 
ㅣWarranty and Responsibilityㅣ 

All products of SEASUN BIOMATERIALS 
are tested under rigorous quality 
management processes. SEASUN 
BIOMATERIALS Inc. guarantees to ensure 
the quality  of the product during warranty 
period. If any problems relating to the 
quality of the product are found, please 
contact the headquarters immediately. 

 

ㅣQuality Control Systemㅣ 

All aspects of the quality management 
system, product creation, quality assurance, 
and supplier qualifications are certified to 
ISO 13485, KGMP. 

 

ㅣInquiries and customer service (A/S)ㅣ 

Send us an e-mail (as@seasunbio.com) to inquire 
about the product. 
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1. Intended Use 

 

U-TOP™ COVID-19 Detection Kit is an in vitro  diagnostic  product  intended  
for  Real-time PCR detection of new Coronavirus (2019-nCoV) infection in 
upper and lower respiratory specimens (such as nasopharyngeal or 
oropharyngeal swabs, sputum, lower respiratory tract aspirates, bronchoalveolar 
lavage, and nasopharyngeal wash/aspirate or nasal aspirate) collected from 
individuals with suspected COVID-19 who present clinical signs or meet 
COVID-19 epidemiological criteria. 

Result are for the identification of 2019-nCoV RNA in the specimens. Positive 
results are indicative of active or non-active infection of 2019-nCoV but do not 
indicate the co-infection of other bacteria and viruses. 

Negative results do not preclude 2019-nCoV infection and should not be used as 
the sole  basis for patient management decisions. Negative results must be 
combined with clinical observations, patient history, and epidemiological 
information. 

The U-TOP™ COVID-19 Detection Kit kit is produced  and optimized for using 
CFX96 real-time  PCR detection system (Bio-Rad) or ABI 7500 (Thermofisher) 
Real-time PCR system. This kit         is intended for use by only qualified and 
well trained clinical laboratory personnel specifically instructed and trained in 
the techniques of real-time PCR and in vitro diagnostic procedures. 

Please read this user guide carefully and check the components in the product 
before first use. 

 

 

2. Product Configuration 

 

The U-TOP™ COVID-19 Detection Kit uses Peptide Nucleic Acid (PNA) based 
real-time PCR technique to in vitro reverse transcription of 2019-nCoV RNA 
followed with DNA amplification and detection. The kit targets 2019-nCoV 
specific genomic regions of ORF1ab and Nucleocapsid 

(N) gene. The PNA probes for the detection of 2019-nCoV are labeled FAM  
(ORF1ab) and HEX  (N gene) fluorescent dyes. PNA is an artificial analog of 
DNA which has extreme thermo and enzyme stability in addition to high 
specificity to the target nucleic acid with its neutrally charged 
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peptide backbone. Since PNA is not cleaved by enzymatically, it does not 
produce false positive results and the diagnostic grey zone as well. 

The kit includes an Internal PCR Control (IPC) to evaluate the detection 
performance as well     as enzyme activity and PCR equipment productivity. 
IPC probe is labeled with Texas Red fluorescent dye which uses independent 
fluorescence detection channel from 2019-nCoV targets. The kit also uses a 
dUTP/UNG carryover preventation system to avoid cross and carryover 
contamination of PCR and subsequent false positive results. 

 

 

3. Kit Components and Packaging Specifications 

 

 
The kit is composed of 2X Reaction Buffer, Enzyme Mix, Reaction Mix, Positive 
and Negative Control. 

 

 

N
o. 

label Ca
p 

Volume / 
quantity 

1 2X Reaction 
Buffer 

 

 
750㎕ / 2ea 

 
2 

Enzyme Mix  

 
100㎕ / 1ea 

 
3 

Reaction Mix  

 
400㎕ / 1ea 

 
4 

Positive Control  

 
200㎕ / 1ea 

 
5 

Negative 
Control 

 

 
200㎕ / 1ea 
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4. Storage and Handling Requirements 

 

- Store all reagents at -25 to -15°C. 

- Use the reagents within 3 months once opened 

- Completely thaw the reagents before each use 

- Avoid excessive freeze/thaw cycles 

- Vortex and spin down briefly the reagents before each use 
 

 

5. Additional Materials and Equipment 

 

U-TOP™ COVID-19 Detection Kit includes reagents for nucleic acid amplification 
and detection. The kit does not include reagents for extracting viral RNA. 
Please prepare RNA extraction kit or reagents and additional materials in below 
before the test. 

 
- RNA extraction reagents for extracting RNA from sputum, 

bronchoalveolar lavage, oropharyngeal or nasopharyngeal smears (We 
recommend to use a RNA extraction reagent with license of in vitro 
diagnostic medical device) 

- Real-time PCR system: CFX96 real-time PCR detection system (Bio-
Rad) or ABI 7500 Real-time PCR System (Thermo Fisher Scientific) 

- 96 well White plate or Low-Profile 0.2ml PCR Tubes, white 

- Sealing Film or Optical flat Cap Strips for 0.2ml tube strips/plates 

- Roller or Film sealing paddle 

- 1.5ml micro tubes 

- Vortex and micro-centrifuge 

- Sterilized pipette tips with filters 

- Centrifugation of micro plate 
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6. Warnings and Precautions 

 

- For in vitro diagnostic use only 

- Use under the guidance of physicians and specialists. 

- Please read this user guide carefully before first use. 

- Sensitivity may lowered with prolonged exposure to room temperature or 
light. 

- Keep refrigerated between -15℃ ~ -20℃ away from UV/sunlight. 

- Avoid to use if the kit is contaminated with test sample. 

- Keep clear the external environment, always use it in a clean place. 

- Only use sterilized single-use micro filter tip. 

- Strong external impact may damage the screw tube. 

- If any abnormality is observed, stop the experiment, contact the 
manufacturer. 

 

 

7. Specimen Collection, Handling and Storage 

 

Inadequate or inappropriate specimen collection, storage, and transport are 
likely to yield false test results. Training in specimen collection is highly 
recommended due to the importance of specimen quality. 

 
- Collecting specimen : Refer to Interim Guidelines for Collecting, Handling, 

and Testing Clinical Specimens from Patients Under Investigation (PUIs) for 
2019 Novel Coronavirus (2019-nCoV). 
https://www.cdc.gov/coronavirus/2019-nCoV/guidelines-clinical-
specimens.html 

Follow specimen collection device manufacturer instructions for proper 
collection methods. Swab specimens should be collected using only swabs 
with a synthetic tip, and an aluminum or plastic shaft. Calcium alginate swabs 
are unacceptable and cotton swabs with wooden shafts are not 
recommended. Place swabs immediately into sterile tubes containing 2-3 ml 
of viral transport media. 

 
- Shipping : Specimens must be packaged, and transported according to the 

current edition    of the International Air Transport Association (IATA) 

http://www.cdc.gov/coronavirus/2019-nCoV/guidelines-clinical-specimens.html
http://www.cdc.gov/coronavirus/2019-nCoV/guidelines-clinical-specimens.html
http://www.cdc.gov/coronavirus/2019-nCoV/guidelines-clinical-specimens.html
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specimens at 2-8°C and ship overnight to the lab on ice pack. If a specimen 
is frozen at -70°   C ship overnight to the lab on dry ice. Additional useful and 
detailed information on packing, shipping, and transporting specimens can be 
found at Interim Laboratory Biosafety Guidelines for Handling and Processing 
Specimens  Associated with Coronavirus Disease  2019 (COVID-19). 

https://www.cdc.gov/coronavirus/2019-nCoV/guidelines-clinical-
specimens.html 

 

 

8. How to Use 

 

 Preparation before test 

U-TOP™ COVID-19 Detection Kit uses RNA extracted from Sputum, 
Bronchoalveolar lavage, Oropharyngeal or Nasopharyngeal smears as 
template for PCR detection. This kit does not include reagents for 
extracting viral RNA. The nucleic acid extraction systems tested with the U-
TOP™ COVID-19 Detection Kit were shown below. In addition to the     kits 
shown below, it is possible to use other RNA extraction kits or reagents 
available for using sputum, bronchoalveolar lavage, oropharyngeal or 
nasopharyngeal smears. RNA Extraction reagents have different names 
and characteristics for each manufacturer, the reagents should be used 
following the manufacturer's instructions. Experimental result may varied 
depended on the extraction methods and reagents. 

 

 

Specim
en 

Manufactu
rer 

Mod
el 

 
sputum, 
bronchoalveolar 
lavage, 
oropharyngeal or 
nasopharyngeal 
smears 

QIAGEN QIAamp DSP virus kit 

 
PANAGEN
E 

Equipment: PANAMAX™ 48 
Reagent: PANAMAX™ Viral 
DNA 
extraction kit 

* RNA extraction proceeds according to the manufacturer's protocol. 

http://www.cdc.gov/coronavirus/2019-nCoV/guidelines-clinical-specimens.html
http://www.cdc.gov/coronavirus/2019-nCoV/guidelines-clinical-specimens.html
http://www.cdc.gov/coronavirus/2019-nCoV/guidelines-clinical-specimens.html


10 

U-TOP™ COVID-19 Detection Kit 
 

 

Real-time PCR 

instrument 

setting 

Result 

interpretation 

2x Reaction Buffer 15ul 

Enzyme Mix 1ul 

Reaction Mix 4ul 

RNA 10ul Reagent preparation 

(Vortex and spin down all 

reagents before use) 

 

RNA extraction 

(use appropriate reagents) 

 
 
 

 

 Summary of Preparation and Testing Process 

 

 

< Work flow of 2019-nCoV detection > 
 

 PCR mixture preparation 

Clean and decontaminate all work areas, and equipment as well as all 
supplements e.g. pipette, vortex, micro centrifuge prior to use to minimize 
the risk of nucleic acid cross- contamination. 

PCR mixture preparation step should be performed on ice or cold-block, if 
possible. Place the Enzyme mix always on ice or cold-block during the test. 

Pipetting of Positive control is recommended to be done in a separate area, 
from preparation of PCR Mixture. Always change pipette tips in-between 
patient sample elution and after pipetting each component. Add the 
Positive Control in PCR plate at last, to avoid the contamination. Positive 
control contains high concentration of viral nucleic acid. 

Prepare PCR mixture according to the following table. It is recommended 
to prepare 110% of the calculated amount of PCR mix to account for 
pipetting carryovers. Be sure to calculate 2 extra reactions for a Positive 
and a Negative Control. 

 

Reaction mixture 
 

 
Reaction mixture 

- 2X Reaction Buffer = 15 X N X 
1.1* = ul 

- Enzyme Mix = 1 X N X 1.1* = ul 
- Reaction Mix = 4 X N X 1.1* = ul 

 

< PCR mixture > 

Reagent Volume(ul

) 

2X Reaction Buffer 15 

Enzyme Mix 1 

Reaction Mix 4 

Template RNA 10 

Total 30 
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① The PCR mixture shown in above table is for one reaction. 

 
② When more than one specimen are tested, the reagents (2X Reaction 

Buffer, Enzyme Mix, Reaction Mix) except the extracted RNA of the 
specimen are prepared with number of the specimens. 

 

*Dispensing Sample, Positive and Negative control in 96 plate are irrelevant 
(No fixed position) 

 

③ Add the PCR mixture as 20μl/well in the PCR plate in the same order as 
the well information, and add 10μl of RNA extracted from the specimen. 
(Up to 94 samples can be analyzed, Be sure to pay attention to Positive 
control (1well) and Negative control (1well) dispensing) 

 
④ This kit is a product that qualitatively examines the presence or absence 

of a 2019- nCoV (COVID-19) infection. The infection status is shown with 
PCR Threshold Cycle     (Ct) value. Ct for amplification curve is detected 
if viral RNA is present and amplified. If the Ct value does not appear, 
check an amplification curve regards to Internal Positive Control (IPC) to 
confirm the PCR is working properly. 

 
⑤ Seal the PCR plate with 8-Cap Strips, completely absorb it using a roller, 

and spin down using a micro plate centrifuge to collect the contents 
downward and remove extra air bubbles. 

* If flat 8-cap strips are not used, it can be replaced with PCR plate sealing film. 

* When using a sealing film, evaporation may occur during PCR process if it is 
not completely adsorbed, which may affect the analysis of the results. 
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 CFX96 and Software Operation - 1 (New experiment) 
① Turn on a computer and CFX96 with power switch of the instrument 

located on the back. At the same time as the start, the CFX96 
performs a self-check automatically. 

 

Figure 1. Front view of CFX96 Real-time PCR System 
 

 
② Press the Door button on the front of machine to display the 96 well 

thermal block. Place the 96 well white plate required for the reaction in 
the well of the thermal block. 
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③ Run the CFX Manager software of the computer connected to the CFX96. 

 

 

 

④ Select 'Create a new Experiment' (This step proceed to the initial assay and 
refer to Section 

 for repeated afterwards) 
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⑤ Select the „Edit Selected‟ button on the right side of the window to open 

the window shown below 

 

 

 

⑥ When the Run setup window appears, set the conditions for each item. 

Set “Sample volume” to 30 ul. 

• Insert Step: Input reaction condition, set temperature and time 

• Insert GOTO: Specify the cycle to repeat 

 

Step Te
mp 

Time Cycle 
(repeat) 

cDNA 
synthesis 

50℃ 30 
min 

1 

 

 
Amplification 

95℃ 15 
min 

1 

95℃ 30 
sec 

 
42 

60℃ 30 
sec* 

72℃ 30 
sec 

* Collect fluorescence signal after reaction for 60℃ / 30 sec 
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⑦ Press the OK button to save the protocol. 

 

 

 
⑧ Select „Edit Selected‟ on the Plate tab. 
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⑨ Select 3 fluorescence (FAM, HEX, and Texas Red) and the wells to be 

analyzed and then click OK. 

 

 

 

⑩ Specify the positive control well, select “Positive Control” from sample 

type, and input 3 detection fluorescences in the load (Select FAM, HEX, 
Texas Red). 
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⑪ Specify the negative control well, select “Negative Control” from sample 

type, and input 3 detection fluorescences in the load (Select FAM, HEX, 
Texas Red). 

 

 

 
⑫ Select BR white from Plate Type < Settings 
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⑬ Select a block (PCR machine) to use and press the 'Close Lid' button to 

close cover of the CFX96 machine. After the cover is completely closed, 
press 'Start Run' to start the amplification with selecting the folder to 
save the test result. 
* Store a file in an easy-to-find location. 

 

 

8.5 CFX96 and Software Operation - 2 (Existing experiment) 

① If you have an existing analysis file, you can easily open it and re-use for 

further. Double click on an existing file to open it and select sequentially 
'File > Repeat Experiment'. 
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② Select 'Next' to proceed to the next step. 

③ In the Plate tab, select 'Edit Selected' to select the well containing the 

specimen. 

The fluorescence channel, plate type, and volume are already selected and are 
therefore can passed. 
④ Finally, select 'Start run' to select the location where the analyzed file will be 

saved. 

* Store files in easy-to-find locations. 
 
 

 

 ABI7500 and Software Operation - 1 (New experiment) 
① Turn on a computer and ABI7500 with power switch of the instrument 

located on the back. At the same time as the start, the ABI7500 performs 
a self-check. 

 

 

Figure. Front view of ABI7500 Real-time PCR System 
 

 

② Press the Door button to display the 96 well thermal block. Be sure to 
input the 96-well PCR plate in proper direction. 
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③ Run 7500 Software of the computer connected to the instrument and 

select New Experiment. 
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④ Input the options shown in below “7500 (96well) > Quantitation-Standard curve 

> TaqMan@ Reagents > Standard (2 hours to complete a run)” and press Plate 
Setup. 

 

 
⑤ Click “Add New Target” and set Target Name and Reporter as shown below 

1. ORF1ab: Reporter FAM, Quencher NFQ-MGB 

2. N gene: Reporter JOE, Quencher NFQ-MGB 

3. IPC: Reporter TEXAS RED, Quencher NFQ-MGB 
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3 

 
 
 

 

⑥ Click “Add New Sample” and set sample number. Be sure to input “Positive 
Control (PC)”, “Negative Control (NC)”. 

 

 
 

 

⑦ Go to “Assign Target and Samples”, set targets and well positions for PC, 

NC and Samples to analyze. 

1. Positive Control: Click Positive Control Well from “View Plate Layout”. Select 
“PC“ from 

(shown in figure below) and activate all 
targets from ”S“ for all 3 targets from
 (shown in figure 
below) 

(shown in figure below) then 
activate 

 

 

33 

2 

1 

①1 

②2 
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3 

2 

1 

 
 
 

 

2. Negative Control: Click Negative Control Well from “View Plate Layout”. Select 
“NC“ from 

(shown in figure below) and activate all 
targets from ”N“ for all 3 targets from
 (shown in figure 
below) 

(shown in figure below) then 
activate 

 

 
 

3. Sample: Click Wells with samples from “View Plate Layout”. Select “Sample“ from ①1     

(shown 

in figure below) and activate all targets from ②2     (shown in figure below). 
 

3 3 

2 

1 

②2 

①1 
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⑧ Select “None” from “Select the dye to use as the passive reference” 

 

 
 

 
⑨ Selecting the “Run Method” button open a window as shown below. 
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⑩ Go to “Tabular View”. Set the PCR condition as shown in below and set 
“Reaction volume Per Well” to 30ul. 

 

 

 

Step Te
mp 

Time Cycle 
(repeat) 

cDNA 
synthesis 

50℃ 30 
min 

1 

 

 
Amplification 

95℃ 15 
min 

1 

95℃ 30 
sec 

 
42 

60℃ 30 
sec* 

72℃ 30 
sec 

 

* Collect fluorescence signal on Hold for 60℃ / 30 sec 
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⑪ Press “File” > Press “Save As” and choose a location to save the file then click 

“START RUN“ to start amplification. 
* Store files in easy-to-find locations. 
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8.7 ABI7500 and Software Operation - 2 (Existing experiment) 
① If you have an existing analysis file, it can be used for further test easily. 

Click „File> Open. 

 
 
 

② Select the “COVID19.edt” file provided. 
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② Input the sample information in the “Plate setup” and proceed in the same 

order as above. 

Proceed with reference to ⑦ in 5.3. 

 

 

9. Result Interpretation 

 

 
 Base line and threshold setting 

We recommend to use the baseline setting which is automatically adjusted 
by the instrument. However, the baseline setting can be adjusted manually 
in case of production of background noise signal in PCR initiation phase. 
For adjusting manually, be sure the Thresholds always should be set to fall 
within exponential phase of the fluorescence curves and above any 
background signal. The threshold value for different instruments varies due 
to different signal intensities. 
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 Quality Control 

- Negative Control : Both ORF1ab and N of 2019-nCoV must not be 
detected, and the Ct value of IPC should be ≤38. 

- Positive Control : Both ORF1ab and N of 2019-nCoV must be detected, 
and the Ct value of IPC should be ≤38. 

If negative and positive control results are not as described above, the 
test results of the entire batch are invalid 

- Internal Control : If the result for a specimen is 2019-nCoV RNA not 
detected, the Ct value of the IPC must be ≤38, otherwise the result of 
that specimen is inconclusive;        if the result for a specimen is 2019-
nCoV RNA detected, the Ct value of the IPC is         not required to be 
considered valid. Positive and Negative controls should meet the  
requirements listed in the below table to ensure valid results. 

 

 

Contr
ol 

Results (Ct ≤ 
38) 

ORF1ab 
(FAM) 

N 
(HEX) 

Negative - - 

Positive + + 

 
 Interpretation of Results 

If the values of the controls are conclusive, refer to the table below to 
determine the infection status. 

 
Results (Ct ≤ 38) 

Interpretation 
ORF1ab 
(FAM) 

N 
(HEX
) 

IPC 
(TexasRed) 

- - + Negative (Absence of 2019-
nCoV RNA) 

+ - +/- Positive (Presence of 2019-nCoV 
RNA)* 

- + +/- Positive (Presence of 2019-nCoV 
RNA)* 

+ + +/- Positive (Presence of 2019-
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nCoV RNA) 

- - - Invalid** 
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* Result is suggestive of: 1) a sample at concentrations near or below the 
limit of detection of the test, 2) a mutation in one of the target regions, or 
3) other factors 

** Re test after confirmation of PCR mixture preparation step, PCR protocol 
and Kit storage condition and validity. 

 

 

10. Limitations 

 

- For in vitro use only. 

- For professional use only. 

- This test is a qualitative test and does not provide the quantitative value 
of viral load in the original specimens. 

- The specimens to be tested shall be collected, processed, stored and 
transported in accordance with the conditions specified in the 
instructions. Inappropriate specimen preparation and operation may lead 
to inaccurate results. 

- Extraction and amplification of nucleic acid from clinical samples must be 
performed according to the specified methods listed in this procedure. 
Other extraction approaches and processing systems have not been 
evaluated. 

- Amplification and detection of 2019-nCoV with the this kit Detection Kit 
has only been validated with the CFX-96 Real-time PCR Detection system 
and Applied Biosystems®  7500 Real-Time PCR instrument. Use of other 
instrument systems may cause inaccurate results. 

- False-negative results may occur if the viruses are present at a level that 
is below the analytical sensitivity of the assay or if the virus has genomic 
mutations, insertions, deletions, or rearrangements or if performed very 
early in the course of illness. 

- This kit uses an UNG/dUTP PCR products carryover prevention system 
which can prevent contamination caused by PCR products. However, in 
the actual operation process, the amplicon contamination can be avoided 
only by strictly following the instructions of PCR laboratories. 
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11. Assay Performance 

 

 Limit of Detection 

- Limit of detection (LoD) was determined as the lowest concentration of 
2019-nCoV that at which the U-TOP™ COVID-19 Detection Kit can detect 
at a ≥95% positive rate. The LoD was determined by limiting dilution 
studies using characterized samples. 

- The test designed for detection in vitro transcribed RNA (ORF1ab and N) 
of known titer (RNA copies/μL) spiked into pooled sputum samples. 

- A preliminary LoDs for each target were determined testing triplicate 
samples with 10- fold serial dilutions (Table 11.1). 

- A confirmation of the LoDs were determined using 3-fold serial dilution 
samples with  20 replicates (Table 11.2). 

- The LoD was determined as 10 copies/reaction as the lowest 
concentration where ≥ 95% of the replicates were positive. 

 

Table 11.1. A preliminary LoD for each target 

 
 ORF1_

ab 

Concentration 1X10
^5 

1X10
^4 

1X10
^3 

1X10
^2 

1X1
0 

Positive total 3/3 3/3 3/3 3/3 3/3 

Mean Ct 25.4 29.6 32.7 35.5 37.
2 

Standard Deviation 
(Ct) 

0.4 0.1 0.2 0.3 0.1 

 
 N 

gene 

Concentration 1X10
^5 

1X10
^4 

1X10
^3 

1X10
^2 

1X1
0 

Positive total 3/3 3/3 3/3 3/3 3/3 

Mean Ct 25.3 28.5 32.5 35.4 37.
0 

Standard Deviation 
(Ct) 

0.1 0.3 0.3 0.2 0.1 
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Table 11.2. A confirmation LoD for each target 

 
 ORF1_

ab 
N 
gene 

Concentrati
on 

10^1 10^0
.5 

10^0
.1 

10^1 10^0
.5 

10^0
.1 

Positive 
total 

20/2
0 

16/2
0 

6/20 20/20 18/2
0 

11/2
0 

Mean Ct 36.8
8 

NA NA 36.89 NA NA 

SD (Ct) 0.5 NA NA 0.38 NA NA 
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 Inclusivity (analytical sensitivity) 

- All primer as well the detection probe sequences are selected based 
on the research papers and nucleic acid sequences for 2019-nCoV 
comparing with other microorganisms and viruses include SARS CoV, 
MERS CoV and human Coronavirus sequences in a public database 
National Center for Biotechnology Information (NCBI) as of February, 
2020. 

- All the alignments of 2019-nCoV show 100% identity of the 
oligonucleotide composed  in the kit. 

- In summary, the 2019-nCoV rRT-PCR assay ORF1ab and N, designed for 
the specific detection of 2019-nCoV only, showed no significant 
combined homologies with other coronaviruses, or human microflora that 
would predict potential false positive results. 

 
 Specificity (Cross reactivity, Interfering substances) 

- Evaluation of analytical specificity of the kit was conducted using both in 
silico analysis and wet testing against pathogenic organisms mainly 
found in the human respiratory tract. 

- As a result of BLASTn analysis of the primers and probes included in this 
kit against gene bank /blast.ncbi.nlm.nih.gov/ with default settings, only 
the 2019-nCoV isolates including Bat coronavirus RaTG13, complete 
genome were found that have 100% of sequence homologies with the 
queries. 

- In addition to the in silico analysis, the nucleic acid extracted from the 
pathogens found in human respiratory tract were tested with U-TOP™ 
COVID-19 Detection Kit. Each pathogen shown in the table below was 
tested in triplicate with the nucleic acid concentrations of 15ng/ul. 

- In addition to the cross reactivity test, the kit  was  evaluated with the  
presence  of PCR interfere substances in addition to the target RNA of 
2019-nCoV to test the PCR interfere as well. 

- All results of the cross reactivity test using the non-specific nucleic acids 
were negative, and no PCR inhibition and non-specific reaction was 
appeared with addition of PCR interfere substances. 
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< Substances used in specificity (Cross reactivity, PCR 
interfere) test > 

Target Nonspecific substances 

 
 
 
 
 
 
 
 
 
 
 

 
Nucleic 
acids 

Human coronavirus 
OC43 Human 
coronavirus HKU1 
Human coronavirus 
NL63 Human 
coronavirus 229E 
SARS-coronavirus 
MERS-coronavirus 

Adenovirus 1 KBPV-VR-1 
DNA Adenovirus 3 KBPV-
VR-2 DNA Adenovirus 8 
KBPV-VR-3 DNA 
Enterovirus, Coxsackievirus B1 KBPV-VR-
13 RNA Enterovirus Coxsackievirus B2 
KBPV-VR-14 RNA Enterovirus 
Coxsackievirus B3 KBPV-VR-15 RNA 
Influenza A virus H3N2 KBPV-VR-32  RNA 
Influenza A virus H1N1 KBPV-VR-33 RNA 
Parainfluenza virus KBPV-VR-44 RNA 
Parainfluenza virus KBPV-VR-45 RNA 
Human 
metapneumovirus 
Chlamydia pneumoniae 
Haemophilus influenzae 
Listeria monocytogenes 
Neisseria meningitidis 
Streptococcus agalactiae 
Streptococcus 
pneumoniae Legionella 
pneumophila 
Mycobacterium 
tuberculosis 
Streptococcus pyogenes 
Bordetella pertussis 
Mycoplasma pneumoniae 
Pneumocystis jirovecii 
(PJP) Candida albicans 
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Pseudomonas aeruginosa 
Staphylococcus epidermis 
Staphylococcus salivarius 
Human gDNA (Hela 
gDNA) 

 

 
PCR 
interfere 

Human nasal wash 
Human genomic 
RNA Mucin 
(60ug/ml) Human 
blood 2% 
Tobramycin 
(4ug/ml) 
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 Clinical evaluation 

Clinical specimens were tested with the U-TOP™ COVID-19 Detection kit 
at three different experimental sites by using total 90 nucleic acid 
extracts. For each of the sites, an established comparator was used. The 
calculated Positive Percent Agreement (PPA) and Negative Percent 
Agreement (NPA) were shown in table below. 

 

Clinical evaluation 
Comparator 

Agreement 
(%) Negati

ve 
Positive 

 

 
U-
TOP™ 
COVID-
19 

Site 1 
(SH) 

Negativ
e 

7 - NPA: 7/7 
(100%) 

Positive - 3 PPA: 3/3 
(100%) 

Site 2 
(GC) 

Negativ
e 

10 - NPA: 10/10 
(100%) 

Positive - 10 PPA: 10/10 
(100%) 

Site 3 
(SB) 

Negativ
e 

30 - NPA: 30/30 
(100%) 

Positive - 30 PPA: 30/30 
(100%) 

Tot al 
Negativ
e 

47 - NPA: 47/47 
(100%) 

Positive - 43 PPA: 43/43 
(100%) 

NPA: Negative Percent Agreement, PPA: Positive Percent Agreement 
 

 Analytical Reproducibility 

The analytical reproducibilities of the kit were evaluated with triplicates 
using 3 different PCR instrument, 3 different Lot of the kit in 3 different 
days by 3 technicians. The results are summarized in table below. Briefly 
the reproducibilities were between 98.4 - 99.7% while estimated 
standard deviations were 0.1-0.4. 

 

Step Total reaction Reproducibility 
(CV%) 

Standard 
Deviation 

3 Lot 9 99.1-99.7% 0.1-0.2 

3 Technician 27 98.9-99.6% 0.1-0.3 
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3 Instrument 27 98.4-99.6% 0.1-0.4 

3 Day 27 98.9-99.5% 0.1-0.3 
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12. Result interpretation using U-TOP™ COVID-19 Analyzer 

 

 Data export from CFX 96 (Bio-Rad) and ABI 7500 (ThermoScientific) 
<CFX 96 real-time PCR system> 

① After the PCR is completed, export the data as shown in figure below. 

- CFX Manager 1.6: Tools → Export All Data Sheet to Excel → Save the 
data in a desired folder 

- CFX Manager 3.0: Export → Export All Data Sheet to Excel → Save the 
data in a desired folder 

- CFX Manager 3.1: Export → Export All Data Sheets → Excel 2007 (*xlsx) 
→ Save the   data in a desired folder 
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<ABI 7500> 
① Adjust target threshold values to 10000 from Amplification plot 
“Options”. Target 1, 2 

and 3 should be selected individually for the adjusting. 

 

 
* If you have background noise signal on Negative control or on the 

samples, the baseline setting can be adjusted manually. Please be sure 
the Thresholds always should be set to fall within exponential phase of 
the fluorescence curves and above any background signal. The 
threshold value for different instruments varies due to different signal 
intensities. 

 
 

 

② After adjusting the threshold, click “Re analyse” to complete the analysis 
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2 

1 

 
 
 

 

③ Select all wells to be analyzed (shown in 1) and click “Export” (shown in 

2) to export data in excel. 

 

 

 
④ Check the box in front of “Results”, “Amplification data”. 
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1 

2 

3 

 
 
 

 

⑤  Select  “Separate  Files”  (Shown  in  1)  and  choose  the  location  to  
save  “Results”, “Amplification data” data (Save the files in a same folder). 

“Start Export” to save the files (Shown in 3). 

*Save the files in an easy to find location. 
 

 

 Result Interpreting with U-TOP™ COVID-19 Analyzer 

① Run the U-TOP™ COVID-19 Analyzer. 
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② Select your PCR platform. 

 

 
③ Click “New analysis”. 

 

 

④ Set your test date. 
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⑤ Import the previously exported data from “CFX96” or “ABI 7500”. Files can 
be imported as folder type (e.g. “COVID-19” shown in figure below). 

 

 

⑥ Positive(    ) and Negative Control(    )s are automatically selected on 
the first screen. 

 

 

⑦ The infection status can be confirmed by selecting the wells to analyze 
from the PLATE MAP. 

 in PLATE MAP indicates COVID-19 
Positive  in PLATE MAP indicates 
COVID-19 Negative 

in PLATE MAP indicates Invalid result (See TROUBLE SHOOTING) 
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“Sample name/#, Patient ID, Name, Gender, Date of Birth, Comment” can be 
entered additionally. The entered informations are reflected in the report. 

 

 
 

⑧ See the Report with “Preview report”. 
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⑨ Use the print button to print the report. 
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13. Trouble shooting 

 

 

Problem Caus
e 

Solutio
n 

 

 
Fluorescence 
signal is not 
detected in all 
samples 

 
Error of the PCR reaction 

Review if anything is 
missing during the 
preparation process.. 

If the storage conditions 
of the kit are not 
appropriate, or the 
expiration date has 
expired 

Repeat the test after checking 
the storage conditions and 
expiration date 

 
 

 
Fluorescent 
signal is low 
in all samples 

If the PCR reagents were 
not mixed correctly 

Proceed the test after 
review of PCR mix 

Long storage at room 
temperature or light 

 
Dispose the kit. 

 
If the expiration date has 
passed 

Check the expiration date 
of the kit. 

 
 
 

Signal 
detection in 
Negative 
Control 

If the PCR mixture is 
contaminated 

 
Discard the PCR mixture. 

 

 
If the experiment place 
or the tool is 
contaminated 

Check whether the test site 
or tool is not contaminated. 
Repeat the experiment with 
new aliquots of all reagents 

 
 
 
If there are 
different 

 
Pipetting error 

 
Check the pipette 

 
Cross contamination 

Be careful with DNA splitting 
and repeat the test. 
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results in the 
same sample 

 
Contaminated 96-well plate 

 
Test with a new 96-well plate. 
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15. Symbols 

 

 

Catalog number 
Do Not Reuse 
(For single use 
only) 

 

Expiration 
Date 

Manufacturer 

 

Temperature limitation 
(Storage 
temperature) 

 

In Vitro Diagnostic 

Medical 

1 

3 

4 

2 

6 
5 

7 

2 

IVD 

LO

T 

RE

F 

http://www.who.int/docs/default-source/coronaviruse/peiris-protocol-16-1-20.pdf
http://www.who.int/docs/default-source/coronaviruse/peiris-protocol-16-1-20.pdf
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Lot number 

 Devic
e 
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